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Programmation objets, web et mobiles en Java
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IDE

Le menu

▶ IDE

▶ JUnit

▶ Maven : Automatisation de production

▶ Gestionnaire de version

▶ Documentation Java
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IDE

Environnement de développement (IDE)

Un IDE est un logiciel regroupant plusieurs fonctionnalités afin de
développer un logiciel, notamment :

▶ Éditeur de texte (e.g. raccourcis claviers, auto-complétion,
navigation dans le code source)

▶ Automation de la compilation (e.g. sélection version Java, gestion
des dépendances, mode de test/debug/production)

▶ Debugger : exécuter le code pas à pas pour comprendre un
comportement ou un bug.
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IDE

Configurer son IDE

IDEs Java
Eclipse, Netbeans, IntelliJ, . . .

▶ Peu importe l’IDE, il faut le configurer et l’apprendre si on veut qu’il
soit utile !

▶ En particulier maitriser les raccourcis claviers permet de réduire la
frustration de devoir faire des changements car ça devient facile.

Rupture du “flow”

▶ Faire l’aller-retour entre le clavier et la souris casse votre “flow”... Ce
n’est pas ergonomique ni agréable.

▶ Par exemple déplacer le curseur sans arrêt et cliquer sur les fichiers
pour les ouvrir.
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IDE

Génération de code

/∗
∗ To change this l icense header , choose License Headers in Project Properties .
∗ To change this template f i l e , choose Tools | Templates
∗ and open the template in the editor .
∗/

package upmc . game ;

/∗∗
∗
∗ @author ptalbot
∗/

public class Game {
}

Template de code

▶ Netbeans : tools -> templates
▶ Eclipse : Window -> Preferences -> Java -> Code Style ->

Code Templates
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IDE

Configuration de l’éditeur

Instructions pour Eclipse :
▶ Utiliser des espaces pour indenter : Window > Preferences >

General > Editors > Text Editors cochez la case insert spaces
for tabs

▶ Fichier en UTF8 : Window > Preferences > General >
Workspace > Text File Encoding : utf8

Source : Cours DLP Master 1 STL / UPMC.
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IDE

Naviguer dans le code

Raccourcis pour Eclipse :
▶ CTRL + SHIFT + R : Ouvrir n’importe quel fichier.
▶ CTRL + O : Aller à une méthode du fichier ouvert.

Les raccourcis suivant sont utiles mais les flèches ne sont pas très
ergonomiques...

▶ CTRL + Flèche gauche / droite : Aller au mot
précédent/suivant.

▶ END : Aller à la fin de la phrase.
▶ HOME : Aller au début de la phrase.

CTRL + SHIFT + L permet de lister tous les raccourcis disponibles et ce
raccourci deux fois permet de les modifier.
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IDE

Manipulation du code

▶ CTRL + SHIFT + 1 : Quick fix d’une typo / erreur de syntaxe / ...
▶ CTRL + SHIFT + o : Organiser / réparer les imports manquants.
▶ CTRL + / : Commenter ou dé-commenter une ligne.
▶ CTRL + SHIFT + F : Correction de l’indentation du code.
▶ CTRL + D : Effacer une ligne.
▶ CTRL + Up / Down : Dupliquer une ligne.

Ce n’est que quelques exemples, n’hésitez pas à essayer de faire tout au
clavier et chercher de nouveaux raccourcis.
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JUnit

Le menu

▶ IDE

▶ JUnit

▶ Maven : Automatisation de production

▶ Gestionnaire de version

▶ Documentation Java
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JUnit

Pourquoi tester son projet ?

▶ Tester une méthode, c’est l’utiliser en avant-première et vérifier que
son interface est bonne.

▶ C’est avoir confiance en son code : les tests permettent de vérifier
qu’une modification dans le code n’entrainent pas de bugs.

▶ C’est gagner du temps au final : débugger peut être très long et
douloureux.

▶ C’est avoir un “flow” plus agréable de travail.
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JUnit

Créer un test JUnit
Eclipse : Clique droit sur le fichier à tester, puis New > JUnit Test Case.

▶ Sélectionner JUnit4.
▶ Sélectionner le bon dossier src/test/java.

Netbeans : Clique droit sur le fichier, puis Tools > Create/Update
Tests.
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JUnit

Tester une méthode

@Test
public void testVerifyMenuChoice () {

// Arrange
int menu = 0;
int maxEntries = 2;
MenuTools tools = new MenuTools ();
// Act
boolean result = tools . verifyMenuChoice (menu , maxEntries );
// Assert
assert ( result == false );

}

▶ @Test : seules les méthodes annotées sont testées.
▶ assert(expr) vérifie que l’expression est bien égale à true.
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JUnit

Assertions JUnit

JUnit fournit de nombreux outils pour tester le code :
▶ assertFalse(e) / assertTrue(e)
▶ fail(msg) fait échouer le test.
▶ assertNotNull(o) vérifie que l’objet o est différent de null.
▶ Voir http:

//junit.org/junit4/javadoc/latest/org/junit/Assert.html
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JUnit

Before / After

On a vu qu’il faut créer l’objet et d’autres données ; on peut automatiser
ce processus :
private MenuTools tools ;

@Before
public void createMenuTools () {

tools = new MenuTools ();
}

La méthode createMenuTools sera appelée avant chaque test.
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JUnit

Tester les exceptions

@Test ( expected = BadMenuChoiceException . class )
public void testVerifyMenuChoiceException () {

// Arrange
int menu = 0;
int maxEntries = 2;
// Act
tools . verifyMenuChoiceException (menu , maxEntries );

}

Une technique plus récente existe avec les @Rule (voir livre).
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JUnit

Qu’est-ce qu’un bon test ? FIRST

▶ [F]ast : Il faut qu’ils soient assez rapides pour être lancés
fréquemment.

▶ [I]solated : Pas d’interaction avec base de données, réseau, . . .

▶ [R]epeatable : Les tests sont déterministes, pas d’aléatoires, si le test
échoue il doit échouer tout le temps et vice-versa si il réussit.

▶ [S]elf-validating : Vérifier si un test est correct ou non ne doit pas
nécessiter notre intervention (e.g. afficher sur la console et vérifier à
l’il nu n’est pas un test !)

▶ [T]imely : N’écrivez plus de Java sans le tester, dès maintenant, une
méthode ≡ un test.

Source : Pragmatic unit testing in Java 8 with JUnit
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JUnit

Écrire un bon test : Right-BICEP

▶ Right Are the results right ?
▶ B Are all the boundary conditions correct ?
▶ I Can you check inverse relationships ?
▶ C Can you cross-check results using other means ?
▶ E Can you force error conditions to happen ?
▶ P Are performance characteristics within bounds ?

Source : Pragmatic unit testing in Java 8 with JUnit
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JUnit

En savoir plus...

Mock objects
Ils répondent à la question de comment tester, par exemple, une classe
utilisant la console ? Une base de données ? Une requête du web ?

Test Driven Development (TDD)
Méthodologie de développement dans laquelle on met les tests au cur du
projet, notamment :

▶ Au lieu d’écrire le code et puis d’écrire les tests, on fait le contraire !
▶ En écrivant les tests d’abord, on réfléchit sur l’interface du code que

l’on va écrire.
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Maven : Automatisation de production

Le menu

▶ IDE

▶ JUnit

▶ Maven : Automatisation de production

▶ Gestionnaire de version

▶ Documentation Java
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Maven : Automatisation de production

Compilation Java

Compiler les sources d’un projet Java peut se faire en console :
> javac Test.java
> java Test

Laborieux

▶ Quand on a des packages et de nombreux fichiers c’est laborieux car il
faut tous les lister...

▶ Il faut aussi gérer les dépendances à la main.
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Maven : Automatisation de production

Automatisation de production

▶ Les IDEs possèdent leur propre système d’automatisation de
production.

▶ Par exemple, on parlera de “projet Eclipse” ou “projet Netbeans”.

Avantages

▶ Le projet est construit automatiquement.
▶ Les dépendances ajoutées au projet sont +- automatiquement prises

en compte.

Désavantages

▶ Dépendant de l’IDE : il faut que tous le monde soit sur le même.
▶ Pas toujours intuitif de savoir comment gérer les options.
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Maven : Automatisation de production

Maven

Maven est un outil non-dépendent d’un IDE particulier.

Caractéristiques

▶ “Convention plutôt que configuration’’ : impose une hiérarchie du
projet.

▶ Build divisé en parties appelées goal, exécutées à tour de rôle.
▶ Le fichier pom.xml est le fichier de configuration.
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Maven : Automatisation de production

Structure du projet

▶ src/main/java : Application/Library sources
▶ src/main/resources Application/Library resources
▶ src/main/filters Resource filter files
▶ src/main/webapp : Web application sources
▶ src/test/java : Test sources
▶ src/test/resources : Test resources
▶ src/site : Site
▶ LICENSE.txt : Project’s license
▶ README.txt : Project’s readme

Source : https://maven.apache.org/guides/introduction/
introduction-to-the-standard-directory-layout.html
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Maven : Automatisation de production

Cycle de vie
Le build est divisé en plusieurs parties. En voici quelques unes :

▶ validate : Vérifie que le projet est complet avec toutes les
informations nécessaires (e.g. présence du pom.xml)

▶ generate-sources : Générer des .java à partir d’autres fichiers
(e.g. grammaire ANTLR4)

▶ compile : Compiler le projet, .java -> .class
▶ test-compile : Compiler les tests JUnit and co.
▶ test : Exécuter les tests.
▶ package : Crée le .jar associé au projet
▶ integration-test : Exécuter les tests d’intégrations (e.g. le logiciel

fonctionne toujours sur un serveur).
▶ install : Installer le package dans le dépôt local de Maven.
▶ deploy : Déployer le package pour partage avec d’autre personne

(release).
Source : voir le livre “Maven : The complete reference”
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Maven : Automatisation de production

Goals

▶ Ce cycle est lancé avec mvn package ou mvn compile suivant
jusqu’où on veut aller.

▶ mvn test lance les tests du projet.
▶ En général mvn goal où vous sélectionnez le goal dans la liste

précédente.
▶ mvn exec:java -Dexec.mainClass="upmc.game.Bataille" pour

exécuter la méthode main.
▶ mvn clean pour nettoyer le projet (supprimer les fichiers générés).

Bien sûr, toutes ces fonctionnalités peuvent être lancées via votre IDE.
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Maven : Automatisation de production

Dépendances

Utiliser une bibliothèque dans un projet

▶ C’est souvent comme installer un logiciel sur votre PC.
▶ Répliquer l’installation est parfois difficile sur les différentes

plateformes.
▶ Quid de la compilation automatisée ?

Cas du C et C++

▶ C’est problématique car chaque bibliothèque s’installe d’une manière
différente.

▶ Perte de temps et difficulté de répliquer et automatiser la compilation
(essayez d’installer C++ Boost Libraries...)
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Maven : Automatisation de production

Répertoire de bibliothèques centralisé

Solution

▶ Un répertoire central listant toutes les bibliothèques d’un langage.
▶ Problème : Cela ne dit pas comment construire une bibliothèque.
▶ Solution : Associer ce répertoire central à un builder particulier.

▶ Python : PIP est le package manager et PyPI est le répertoire.
▶ Javascript : NPM / npmjs.com
▶ Rust : Cargo / crates.io

Choisir un langage, c’est aussi adopter son écosystème.
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Maven : Automatisation de production

Et en Java ?

▶ Répertoire de bibliothèques Java utilisables dans notre projet via
Maven : https://www.mvnrepository.com/

▶ Il suffit de trouver sa bibliothèque sur ce site et de copier/coller la
dépendances dans le pom.xml.

▶ En fait, ce répertoire marche aussi pour d’autres systèmes de build de
Java (Gradle, SBT,. . . )
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Maven : Automatisation de production

pom.xml

<p r o j e c t xmlns=" http : //maven . apache . org /POM/ 4 . 0 . 0 " xm ln s : x s i=" http : //www. w3 . org /2001/XMLSchema−i n s t a n c e "
x s i : s chemaLoca t i on=" http : //maven . apache . org /POM/ 4 . 0 . 0 http : //maven . apache . org / xsd /maven −4 .0 .0 . xsd ">
<mode lVe r s i on>4 . 0 . 0</ mode lVe r s i on>

<group Id>upmc . pcg</ group Id>
< a r t i f a c t I d>pokedeck</ a r t i f a c t I d>
<version>0 . 0 . 1</ version>
<packag ing>j a r</ packag ing>

<name>pokedeck</name>
<u r l>http : //maven . apache . org</ u r l>

<p r o p e r t i e s>
<p r o j e c t . b u i l d . sou r ceEncod ing>UTF−8</ p r o j e c t . b u i l d . sou r ceEncod ing>
<maven . c o m p i l e r . s o u r c e>1 .8</maven . c o m p i l e r . s o u r c e>
<maven . c o m p i l e r . t a r g e t>1 .8</maven . c o m p i l e r . t a r g e t>

</ p r o p e r t i e s>

<d e p e n d e n c i e s>
<dependency>

<group Id>j u n i t</ g roup Id>
< a r t i f a c t I d>j u n i t</ a r t i f a c t I d>
<version>3 . 8 . 1</ version>
<scope>t e s t</ scope>

</ dependency>
</ d e p e n d e n c i e s>

</ p r o j e c t>
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Maven : Automatisation de production

pom.xml : Identification du projet

▶ groupId est l’identifiant d’un groupe de projets, souvent le domaine
d’une entreprise à l’envers : fr.upmc

▶ artifactId est l’identifiant du projet courant.

Le groupId + artifactId + version forment ce qu’on appelle une
“coordonnée’’ ; on l’utilise pour déclarer précisément ses dépendances.

▶ name : Le nom du projet tel qu’il est connu dans l’équipe ou
commercial. Par exemple, “com.google-android-5.0.0” est la
coordonnée mais le nom est “Lollipop”.

Exercice : Ajouter la dépendance JSON au Pokédeck.
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Maven : Automatisation de production

Numéro de version

Le numéro de version d’un logiciel, par exemple 2.0.3-beta, est très
important ; il permet de :

▶ Préciser exactement “à quel point” le logiciel a changé.
▶ Informer les utilisateurs des potentiels incompatibilités avec les

anciennes versions.
En Maven le format de version est le suivant :
<major version >.< minor version >.< incremental version >-<qualifier >
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Maven : Automatisation de production

Semantic versioning

Citation de http://semver.org/ :

Given a version number MAJOR.MINOR.PATCH, increment the:

MAJOR version when you make incompatible API changes,
MINOR version when you add functionality in a

backwards-compatible manner, and
PATCH version when you make backwards-compatible

bug fixes.

Additional labels for pre-release and build metadata are
available as extensions to the MAJOR.MINOR.PATCH format.
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Gestionnaire de version

Le menu

▶ IDE

▶ JUnit

▶ Maven : Automatisation de production

▶ Gestionnaire de version

▶ Documentation Java
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Gestionnaire de version

La gestion old-school
Gérer ses sources à la main. . .
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Gestionnaire de version

Gestionnaire de version

Les gestionnaires de version permettent de :
▶ Travailler facilement à plusieurs ou via plusieurs machines sur un

projet.
▶ Garder une trace de toutes les modifications.
▶ Revenir en arrière sur une partie ou tous le projet.
▶ Tester des fonctionnalités en gardant le projet compilable.
▶ Et bien plus. . .
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Gestionnaire de version

Point culture

Deux grandes familles

1. Gestionnaire de version centralisé (Subversion (svn), CVS, . . . ).
2. Gestionnaire de version décentralisé (Git, Mercurial, . . . ).

La grande différence est que les gestionnaires de version décentralisés
impliquent que tout le monde peut devenir un serveur, et donc que tous
les développeurs possèdent une copie locale des versions.

Avantages

1. Vous pouvez travailler sans être connecté au serveur.
2. Si le serveur crash, l’historique n’est pas perdu et un développeur

peut devenir le serveur.
3. La plupart des opérations sont plus rapides car effectuées en local.
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Gestionnaire de version

Comment ça marche ?

Figure – Situation de base

2 situations

1. J’ai un projet que je veux versionner.
2. Le projet existe déjà et je veux juste le récupérer.
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Gestionnaire de version

Création d’un répertoire

Cette commande est lancée dans le répertoire de votre projet, à la racine
du projet (Pokedeck/).

Pierre Talbot (IRCAM) Outils de dev 38 / 55



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Gestionnaire de version

Ajouter un fichier

Un fichier est ajouté au projet, mais il faudra quand même “valider” cet
ajout avec git commit.
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Gestionnaire de version

Valider les changements

Les changements sur les fichiers ajoutés aux projets sont validés en local.
On peut voir commit comme un push sur un serveur local.
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Gestionnaire de version

Ajouter son projet sur un serveur distant

github devient le serveur référenciel, origin est juste un alias arbitraire
vers l’adresse exacte.
Note : Le commit n’envoie pas les changements sur le serveur distant.
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Gestionnaire de version

Envoyer les commits sur le serveur distant

Avant de partir, ou si une autre personne à besoin de nos changements,
faire un push pour envoyer les commits sur le serveur.
Note : Pour le premier push, vous devez dire explicitement sur quel serveur
et quel branche vous envoyez les changements : git push -u origin
master.
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Gestionnaire de version

Récupérer les commits du serveur distant

Quand on arrive, ou pendant qu’on travaille si une personne a push des
changements qu’on veut récupérer, faire un pull pour récupérer les
changements du serveur.
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Gestionnaire de version

Cloner un projet d’un serveur distant

On récupère simplement le dossier du projet avec git clone.
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Gestionnaire de version

Concrètement

Vous pouvez taper ces commandes dans un shell (ou une console, ou un
bash, . . . ). Elles sont identiques pour tous les systèmes d’exploitations.

Le shell sous Windows
Existe en deux versions :

▶ Une version console (git bash) imitant celle de Linux/MacOSX :
http ://msysgit.github.io/

▶ Une version console (git shell) avec les attributs de Windows (nom de
fichier, ...) : https ://windows.github.com/

Ces outils contiennent plus que une console, mais également une interface
graphique. Si vous voulez utiliser l’interface graphique, le deuxième outil
est probablement le meilleur.
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Gestionnaire de version

Un cours en ligne

Vous pouvez suivre ce tutoriel de 15 minutes :
https://try.github.io/levels/1/challenges/1, il se concentre sur
la ligne de commande mais le nom des boutons dans l’interface graphique
sont similaires.
Lisez également la documentation de l’outil que vous avez choisi
d’installer.

Pierre Talbot (IRCAM) Outils de dev 46 / 55

https://try.github.io/levels/1/challenges/1


.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Gestionnaire de version

Directement dans l’IDE

Il existe des plugins pour git qui sont intégrables à l’IDE, plus qu’à faire
clique-droit > git > ajouter, pour ajouter un nouveau fichier ou lancer
n’importe quelle commande.
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Gestionnaire de version

Github

github.com est probablement le service le plus populaire pour héberger
des projets (principalement open-source) en 2017.

Gestion de projet

▶ But principal : Versionner ses sources.
▶ Mais contient aussi un gestionnaire de ticket (issues) que vous pouvez

tagger.
▶ La possibilité de créer un Wiki.
▶ De récolter des statistiques en tout genre
▶ . . .
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Gestionnaire de version

Ticket Github

Un ticket représente une action à réaliser :
▶ Un bug à résoudre.
▶ Une fonctionnalité à implémenter.
▶ Du code à commenter.
▶ . . .

Vous pouvez fermer automatiquement des tickets en ajoutant dans votre
message de commit : “It closes #2” où 2 est le numéro du ticket.
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Documentation Java

Le menu

▶ IDE

▶ JUnit

▶ Maven : Automatisation de production

▶ Gestionnaire de version

▶ Documentation Java
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Documentation Java

Documentation Java

Voici le lien pour Java 8 : http:
//docs.oracle.com/javase/8/docs/api/overview-summary.html.

▶ Généralement on explore pas la doc pour le fun.
▶ On veut un renseignement précis sur les méthodes qu’une classe

propose.
▶ Mais comment faire pour trouver une fonctionnalité si on ne connaît

pas la classe ?
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Documentation Java

Trouver son bonheur

Il faut exprimer clairement ce qu’on recherche et faire le point sur :
▶ Est-ce que je sais comment faire (via expériences) et qu’il me faut les

noms des classes ?
▶ Si oui, une recherche Google suffit généralement à trouver des

exemples.
▶ Si non, s’il Google ne donne pas de résultat pertinent et qu’on

n’arrive pas à mettre des mots sur ce qu’on recherche, il faut
demander (au prof ou à vos collègues). Vous gagnerez du temps.

▶ Parfois quelque chose qu’on pense simple est en fait plus global et
compliqué et c’est difficile de s’en rendre compte (c’est pour ça qu’il
faut demander).
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Documentation Java

Documenter son code

Vous pouvez facilement faire une documentation comme celle de Java en
documentant votre code avec des balises spéciales.
/∗∗

∗ Returns an Image o b j e c t that can then be painted on the s c r e e n .
∗ The u r l argument must s p e c i f y an abso lu t e { @link URL} . The name
∗ argument i s a s p e c i f i e r that i s r e l a t i v e to the u r l argument .
∗
∗ @param u r l an abso lu t e URL g i v i n g the base l o c a t i o n o f the image
∗ @param name the l o c a t i o n o f the image , r e l a t i v e to the u r l argument
∗ @return the image at the s p e c i f i e d URL
∗ @see Image
∗/
public Image getImage (URL url , String name) {

try {
return getImage (new URL(url , name ));

} catch ( MalformedURLException e) {
return null ;

}
}
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Documentation Java

Documenter son code

Les commentaires sont interprétés en HTML et les balises (@param,
@return, . . . ) décrivent le code et sont interprétées spécialement par
javadoc.
Une liste est disponible : http://docs.oracle.com/javase/7/docs/
technotes/tools/windows/javadoc.html#javadoctags.

En Maven
mvn javadoc : javadoc

▶ Le résultat est dans target/site/apidocs, ouvrez le index.html
avec votre navigateur.

▶ Essayer aussi mvn site pour générer un site Maven.
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Documentation Java

Documentation “Top-down”

Bonne pratique
Privilégier la documentation de plus haut niveau avant de documenter les
spécifiques.
En effet, à quoi sert d’avoir la documentation :

▶ d’une méthode get si on ne sait pas à quoi sert la classe, et
▶ d’une classe si on ne sait pas à quoi sert le projet ?

Privilégier d’abord la documentation en tête de classe et réfléchissez :
“Qu’est-ce que quelqu’un qui arrive sur ce code a besoin de savoir”.
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